# Table of Contents

Table of Figures .................................................................................................................. 2  
Table of Tables .................................................................................................................. 3  
Executive Summary .......................................................................................................... 4  
1.0 Introduction .................................................................................................................. 5  
   1.1 Problem Statement .................................................................................................. 5  
   1.2 Client Background ............................................................................................... 5  
   1.3 Human Potential Program for Professionals Overview ........................................... 6  
2.0 User's Manual ............................................................................................................. 7  
   2.1 Directions to Dr. Anna Pittman’s Website ............................................................. 7  
   2.2 Appropriate Equipment ....................................................................................... 7  
   2.3 Video Structure Description ............................................................................... 7  
3.0 Developer’s Manual .................................................................................................. 7  
   3.1 Installing iMovie .................................................................................................... 7  
   3.2 Storyboards .......................................................................................................... 9  
   3.3 Data File Inventory .............................................................................................. 10  
   3.4 Music Editing: How To ....................................................................................... 12  
4.0 Lessons Learned ....................................................................................................... 17  
   4.1 Timeline/schedule ............................................................................................... 17  
   4.2 Problems and Solutions ...................................................................................... 17  
   4.3 Future work ......................................................................................................... 18  
5.0 Acknowledgements .................................................................................................. 19  
6.0 References ................................................................................................................ 19  
Appendix A – Requirements Document ............................................................................ 20  
Appendix B – Design Document ..................................................................................... 24  
Appendix C – Implementation Report .............................................................................. 27  
Appendix D – Prototyping ............................................................................................... 36  
Appendix E – Refinement ............................................................................................... 41  
Appendix F – Testing and Refinement ............................................................................ 47
Table of Figures

1. Depicts the general storyboard that was used for each HPPP video..........................10
2. File free containing iMovie Library with raw HPPP videos........................................11
3. Files contained on the flashdrive give to Dr. Anna Pittman ........................................12
4. Master patch – Max/MSP...............................................................................................14
5. Gain (volume) levels for each prominent output – Max/MSP........................................15
6. Record to file – Max/MSP...............................................................................................15
7. Current drum track, loop selected, and clickBeat, drumSeq subpatches – Max/MSP........16
8. FCB1010 MDI translation – Max/MSP.............................................................................16
9. Guitar Rig – Max/MSP.....................................................................................................16
10. Digital display of pedalboard configuration – Max/MSP.................................................17
Table of Tables

1. Outlines the eight topics of the Human Potential Program for Professionals .......... 6
2. YouTube links and length of each video .......................................................... 12
Executive Summary

This report provides a detailed description of the Human Potential Program for Professionals (HPPP) CS4624 Multimedia, Hypertext, and Information Access capstone project. The goal of the HPPP project centers around assisting Dr. Anna Pittman by creating introductory video material for her HPPP program. The HPPP program consists of eight one hour modules, each of which has an accompanying two to five minute introductory video provided by this capstone project. These videos feature Dr. Anna Pittman giving a brief overview of the module and highlighting the main topics.

After several meetings with Dr. Anna Pittman to discuss her vision for the introductory videos, a schedule was devised for filming. Dr. Anna Pittman also wanted a logo for HPPP which our team provided. Another aspect of the videos was the accompanying background music. This music was original and used Cycling ‘74’s Max/MSP software to create the final three tracks used in the videos. The raw footage was then edited within Apple’s iMovie software and combined the logo and original music. The material was provided to Dr. Anna Pittman for review. After receiving Dr. Anna Pittman’s comments, the team was able to address each concern and make adjustments. This was an iterative process requiring the team to work very closely with Dr. Anna Pittman.
1.0 Introduction

This document includes the design plans we have for our client and the detailed actions required in order for us to fully deliver our client’s desired vision. Along with our design plan, we discuss requirements and implementation. This report discusses prototyping, refinement, testing, and work to date. This document will include the following six sections as well as the following appendices:

1.0 Introduction,
2.0 User’s Manual,
3.0 Developer’s Manual, and
4.0 Lessons Learned
5.0 Acknowledgements
6.0 References
Appendix A – Requirements Document
Appendix B – Design Document
Appendix C – Implementation Report
Appendix D – Prototyping
Appendix E – Refinement
Appendix F – Testing and Refinement

1.1 Problem Statement

Create eight, five to ten minute introduction videos to support our client’s desired program—which is delivered through nine, one-hour long live sessions with our client. The program our client is attempting to deliver is called the Human Potential Program for Professionals\(^1\), which as she describes it is a way of “learn[ing] to relax the cumulative, cultural fear driving the decision making processes at work and at home, while also mastering tried and true techniques for decreasing stress and anxiety”. It is important that we fully understand the scope of our client’s vision so that we are prepared to help deliver such a program. The topics our client wants to cover are (1) self-awareness, (2) mindfulness, (3) self-regulation, (4) emotional intelligence, (5) compassion, (6) empathy, (7) communication, and (8) motivation. These eight topics align with eight areas of focus in the Human Potential Program for Professionals. Each of our videos will serve as an introduction to one of these eight topics.

1.2 Client Background

Our client is Dr. Anna Pittman who holds a Ph.D. in Consciousness Studies and a Masters in Transpersonal Psychology with twenty years direct experience working with groups and individuals. With that knowledge, we are motivated to deliver a service up to the standard that she has built for herself. Dr. Anna Pittman created the Human Potential Program for
Professionals in order to help organizations function more effectively, and allow their employees to become more fulfilled. For more information on Dr. Anna Pittman, please view her bio page.2

1.3 Human Potential Program for Professionals Overview

This comprehensive program offers simple secrets that successful employees can easily offer to promote confidence, well-being, connection, and productivity in the workplace. The program is group based for all levels of faculty and staff, creating facilitated experience that offers a direct opportunity to transcend the cultural hypnosis of fear, worry, anxiety, and lack. For a complete intake of information and skill sets, this program is offered in nine, one hour sessions, online or live. Through gentle lecture and direct inquiry, with specific techniques, the Human Potential Program for Professionals explores the eight areas as outlined in Table 1.

Table 1. Outlines the eight topics of the Human Potential Program for Professionals.

<table>
<thead>
<tr>
<th>Module</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>One</td>
<td>Self-Awareness</td>
</tr>
<tr>
<td>Two</td>
<td>Mindfulness</td>
</tr>
<tr>
<td>Three</td>
<td>Self-Regulation</td>
</tr>
<tr>
<td>Four</td>
<td>Emotional Intelligence</td>
</tr>
<tr>
<td>Five</td>
<td>Compassion</td>
</tr>
<tr>
<td>Six</td>
<td>Empathy</td>
</tr>
<tr>
<td>Seven</td>
<td>Communication</td>
</tr>
<tr>
<td>Eight</td>
<td>Motivation</td>
</tr>
</tbody>
</table>

To reiterate, our deliverable will be an introductory video for each of these topics. Although Dr. Anna Pittman wants her program to flourish and be open to all professional fields, she has found the Human Potential Program for Professionals is currently particularly appealing to the medical profession.
2.0 User’s Manual

2.1 Directions to Dr. Anna Pittman’s Website

Viewers will be able to access the HPPP introductory video series on Dr. Anna Pittman’s website. At this time, the videos are not available; however, they will be made available in the near future.

2.2 Appropriate Equipment

In order for the user to view the results of our project--The Human Potential Program for Professionals--the user will need a computer or smart device along with Internet access. With this necessary equipment the user will then need the website URL where all the content for the Human Potential Program for Professionals will be posted.

2.3 Video Structure Description

For an outline of the HPPP videos, see Section 4.0 in Appendix B.

3.0 Developer’s Manual

3.1 Installing iMovie

A developer must download the video editing software named iMovie to be able to make edits to a particular video in the future. Here we will outline the necessary steps a developer must follow to download and install iMovie. iMovie is the default video editing application for Mac OS X ONLY. It is created by Apple and used only in its own operating system, Mac OS X. Apple hasn't released any Windows version of iMovie and it has not announced any scheduled plan to developed iMovie for PC. With that said, these instructions will be intended for developers who have access to Mac OS X. It is common for developers who have just purchased a Mac computer to already have iMovie on their system. Please double check whether or not iMovie is already installed on your system before continuing with the following instructions.

There are two options to choose from when deciding how to download and install iMovie. The first option is to download and install from the Apple app store, which is supported on every Mac computer. In order to be able to download content from the Apple app store, the developer must first need an Apple ID account. If you already have an Apple ID account, please consider the possibility of not being able to move data or purchases from an old Apple ID to a new one. To
create a new Apple ID, you must go to the Apple ID site and select Create Your Apple ID. Once you have done this, the following information is necessary in creating the account:

- A valid email address to use as your Apple ID username.
- A strong password.
- Your date of birth.
- Three security questions and answers to verify your identity and a rescue email address.
  You can also use this information to reset your password.

Once you have created your Apple ID account, you will now have access to the content offered on the App Store including iMovie, which should be available for free.
3.2 Storyboards

Title of video scrolls down. Anna’s name appears below it. Logo appears in the center.

CUT TO: Front camera angle of Anna. Anna speaks about specifics of HPPP.

CUT TO: Side camera angle of Anna. Anna continues speaking about specifics of HPPP.
3.3 Data File Inventory

The following section will describe the raw iMovie and Keynote files used to make the HPPP videos and how to access and edit them further. First, iMovie files are accessed in the following way on a computer running OS X:

1. In the Finder, choose Go > Home.
2. Open the Movies folder. Locate the iMovie Library file.
3. Drag the iMovie Library file to your external drive or a new location on your computer.
   (See Figure 2)

The iMovie Library with the HPPP videos can be opened and edited on other computers with iMovie installed.
Figure 2. File tree containing iMovie Library with raw HPPP videos

Figure 2 shows some of the Keynote files used in iMovie. These files can be edited in Keynote and imported into iMovie for further video editing.

The entire contents of the HPPP video project have been placed on a flash drive and will be given to Dr. Anna Pittman. The flash drive includes the raw iMovie video files, the final video files, the music files, the keynote files, and the logo files. The videos are also on YouTube for quick reference as displayed in Table 2.
Figure 3. Files contained on the flashdrive given to Dr. Anna Pittman.

Table 2: YouTube links and length of each video.

<table>
<thead>
<tr>
<th>Video</th>
<th>Link</th>
<th>Length (minutes:seconds)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mindfulness</td>
<td><a href="https://youtu.be/U4aOUxAa1VI">https://youtu.be/U4aOUxAa1VI</a></td>
<td>2:31</td>
</tr>
<tr>
<td>Motivation</td>
<td><a href="https://youtu.be/za2hvcy2X-g">https://youtu.be/za2hvcy2X-g</a></td>
<td>2:33</td>
</tr>
<tr>
<td>Communication</td>
<td><a href="https://youtu.be/swrhnXsATCw">https://youtu.be/swrhnXsATCw</a></td>
<td>3:40</td>
</tr>
<tr>
<td>Emotional Intelligence</td>
<td><a href="https://youtu.be/onBozclISpy8">https://youtu.be/onBozclISpy8</a></td>
<td>3:52</td>
</tr>
<tr>
<td>Empathy</td>
<td><a href="https://youtu.be/QttNpwzAOBg">https://youtu.be/QttNpwzAOBg</a></td>
<td>3:01</td>
</tr>
<tr>
<td>Self Awareness</td>
<td><a href="https://youtu.be/YpXrGe0tYgM">https://youtu.be/YpXrGe0tYgM</a></td>
<td>2:55</td>
</tr>
<tr>
<td>Self Regulation</td>
<td><a href="https://youtu.be/EmDuoZ46mx4">https://youtu.be/EmDuoZ46mx4</a></td>
<td>3:35</td>
</tr>
<tr>
<td>Compassion</td>
<td><a href="https://youtu.be/PM44uBUjy44">https://youtu.be/PM44uBUjy44</a></td>
<td>3:21</td>
</tr>
</tbody>
</table>

3.4 Music Editing: How To

Tutorial on installing Max/setting up hardware:
• The core technology used for creating the background music in the project videos is Cycling ‘74’s Max/MSP, which can be found and purchased at https://cycling74.com/shop. Note that a free trial of Max/MSP is available for download, but the user will be unable to save any work without purchasing the product. Therefore, one must have an account with Cycling ‘74 and a purchased version of Max/MSP in order to save recorded music files to disk using provided record/save functionality within the software. More information about Max/MSP can be found at https://cycling74.com/products/max. Within the product, there is extensive documentation on many of the available objects (functions) in Max, and this documentation is very useful while creating music with the software.

• After purchasing and installing Max, a user can immediately begin programming within a “patcher” window, which is a term for the interface that the user interacts with in Max. A new patch can be created by going to File->New Patcher, and the patch can be saved and reopened as needed.

• To open an existing patch, one should go to File->Open and select the desired file. To open and interact with the patch used to create the music within this project’s videos, download and open the file named “Transparency.maxpat”. Please note that further use and modification of the provided file Transparency.maxpat should cite the original source of the file.
  
  o Note that in addition to Transparency.maxpat, there are other files needed in order to get the full functionality of the designed system, with synthesizer noises coming from the Crystal vst, and with the drum tracks being loops of several measures of a drum track audio file. Additionally, the software Guitar Rig 5 was used as a vst plugin to create guitar effects, triggered by pedals being pressed on the Fcb1010 pedalboard.

  ii.  Fcb1010 + audio interface

• Several pieces of hardware were used in coordination with Max/MSP to create, loop, and record the music played in the videos. Here is a list of the hardware used, which can also be found in the Implementation section of this report:
  
  o Focusrite Scarlett 2i4 USB Audio Interface
  o Behringer Fcb1010 MIDI Foot Controller
  o Multiple ¼ inch instrument cables, 5-pin MIDI cable
  o Electric guitar

• How to set up the hardware with Max:
  1. Plug the audio interface into your computer via USB
  2. Select Options->Audio status, and change the input device to the audio interface in use
  3. Plug the MIDI cable into “MIDI out” on the audio interface and into “MIDI in” on the Fcb1010
  4. Plug an instrument cable from the guitar output into an input on the audio interface
5. (Optional) For use with an external speaker (guitar amplifier), take an instrument cable out of the corresponding output on the audio interface, and into the amp input. Then select Options->Audio status, and change the output device to the audio interface in use.

b. Patch explanation

![Figure 4: Master patch - Max/MSP](image)

- Above is the master patch, Transparency.maxpat, with much of the functionality visible
Figure 5: Gain (volume) levels for each prominent output - Max/MSP

- “Main output vol” → volume for current live guitar output
- “Loop playback” → volume for playback of looped guitar tracks
- “Drum playback” → volume for looped drum track

Figure 6: Record to file - Max/MSP

- Collection of objects used to record the current collection of outputs to a file (t4.aif)
Figure 7: Current drum track, loop selected, and clickBeat, drumSeq subpatches - Max/MSP

- Here we can see the current drum track being looped (1-7), the current guitar loop selected (1-3), and a recording toggle box to notify whether recording is on/off.
- Additionally, the clickBeat subpatch contains a self-timing metronome with a parameterized bpm (beats per minute) and time signature, which can be started and stopped with the start/stop button. The drumSeq subpatch gathers the drum track audio files to be looped upon certain iterations of the self-timing metronome within clickBeat.

Figure 8: FCB1010 MIDI translation - Max/MSP

- The collection of objects and subpatches used to get MIDI data from the Fcb1010 pedalboard, translate this data into MIDI events within Max (using the MIDIEventConverter subpatch found at the top left of the interface), and to the Guitar Rig 5 plugin.

Figure 9: Guitar Rig - Max/MSP

- Certain presets of guitar effects can be loaded into Guitar Rig by reading and loading a saved .fxp file (an instance of Guitar Rig).
Here is a digital layout of the Fcb1010 pedalboard. Note that only the toggle objects labeled 1-10 are applicable to the creation of this music. Each toggle object, and therefore pedal on the pedalboard, has a certain function when activated, as listed below:

- 1, 2, 3, 4, 5: Select from several guitar effects within Guitar Rig
- 6: Start/stop playback of master loop
- 7: Switch to next drum track/synth to be looped
- 8: Start/stop recording of guitar
- 9: Iterate through current guitar loop selected (1-3)
- 10: Delete current guitar loop selected

4.0 Lessons Learned

4.1 Timeline/schedule

For an overview of the HPPP project timeline and schedule see Figures 1 and Figure 2 in Appendix C.

4.2 Problems and Solutions

Throughout the implementation of our project we were confronted with certain issues that we were able to work through and find solutions for. We were rarely discouraged when we came across such issues because we were able to treat them as learning opportunities. In this section, we will describe some of these instances and how we were able to find solutions throughout our implementation.
Our first conflict came early on in the implementation design process. After having gathered the necessary equipment for filming we were ready to begin brainstorming different locations. This task ended up being more difficult than we had predicted. In order to make sure we were on the same page with Dr. Anna Pittman in regards to filming location, we invited Dr. Anna Pittman to an area inside the Moss Arts Center where we had thought would be a good setting to film these videos. We asked that Dr. Anna Pittman be prepared to shoot a trial video at this meeting so that we would be able to consider different variables tied to that setting. After having shot the trial video and editing it, we sent the video to Dr. Anna Pittman for feedback on whether we should continue filming at that location. Dr. Anna Pittman had decided that she felt “disconnected” to the area in Moss Arts Center. This feedback immediately eliminated Moss Arts Center from consideration because it is of utmost importance that Dr. Anna Pittman feels comfortable behind the camera when filming. At this point in time, we had to start thinking outside-the-box and ask ourselves questions like “Should we begin to consider locations off-campus?” Which was ultimately what we decided to do. Our location issue was resolved when we began to focus more on where Dr. Anna Pittman was comfortable rather than what we thought might be best fit at the time. We had finally come to the conclusion to film at The Breathing Space, a location about 10 mins off-campus. This location was great due to the facts that Dr. Anna Pittman felt more comfortable here, variables to consider were more consistent, and was overall more aesthetically congruent with the Human Potential Program for Professionals than locations we had previously considered. This instance was a learning process in the sense that we forced ourselves to consider options that we may have previously thought were not necessary. Along with that, we had not considered too much about how our client might feel in a certain space, we had only considered aesthetics at the time. Through this trial-and-error scenario we were able to learn of conditions in selecting a location that we had not thought of before, which ended up helping us in the long run!

4.3 Future work

There are a couple of avenues in which the HPPP project could potentially expand. First, an introduction video and conclusion video could provide additional value to our eight current introductory videos. Our team originally planned to include a video for Dr. Anna Pittman introducing her entire program. However, with time as a limiting factor, our team and Dr. Anna Pittman determined it was best to focus on the eight videos introducing the modules. Dr. Anna Pittman would be open to discussion about potentially making videos to both introduce and conclude the HPPP.

Dr. Anna Pittman would also be interested in expanding her program to an online form. Currently, she only offers this program with eight or nine one hour in person sessions. There exists potential to migrate this to an online platform of Dr. Anna Pittman’s
choosing. This way, clients could decide whether they wanted Dr. Anna Pittman to deliver all, a portion, or none of the material in person.

5.0 Acknowledgements

This work would not have been possible without the help and guidance of Dr. Edward Fox. Dr. Fox provided valuable feedback and was influential in the revision of this report and the completion of the HPPP video series.

Our team would also like to express gratitude for Dr. Anna Pittman who we were given the opportunity to work with and create the HPPP video series for.

6.0 References


Appendix A – Requirements Document

Table of Contents

Table of Tables .................................................................................................................. 20
1.0 Objectives ..................................................................................................................... 21
2.0 Business Processes ...................................................................................................... 21
3.0 User Roles and Responsibilities .................................................................................. 21
   3.1 Distributor ................................................................................................................ 21
   3.2 Instructor ............................................................................................................... 21
   3.3 Consumers .......................................................................................................... 21
4.0 Terminology ................................................................................................................. 22
5.0 Functional Requirements ............................................................................................ 22
   5.1 Functional Goal ...................................................................................................... 22
      5.1.1 Distribution .................................................................................................. 23
      5.1.2 Revisioning and Restructuring ................................................................. 23
   5.2 Scope .................................................................................................................... 23
   5.3 Performance ......................................................................................................... 23

Table of Tables

1. Defines the terminology and/or acronyms used throughout this report ......................... 22
1.0 Objectives

Our objective is to create meaningful and educational videos for Dr. Anna Pittman’s “Human Potential Program for Professionals” initiative that will help companies and business-professionals maximize their work potential. These videos will serve as an educational series to promote Dr. Anna Pittman’s work in transpersonal psychology. It is our objective to benefit Dr. Anna Pittman by creating videos that accurately and professionally relay her message to her clients. With these videos, Dr. Anna Pittman can expand her business and reach clients through video platforms. Lastly, it is our objective that this project is finished by the end of April, to coincide with the end of the spring semester.

2.0 Business Processes

Our client, Dr. Anna Pittman, currently offers her “Human Potential Program for Professionals” course online or live and does not have accompanying introductory videos. With the addition of our introductory videos, Dr. Anna Pittman’s clients will be able to preview her course content before each session. Dr. Anna Pittman’s courses are thought-provoking and discussion-oriented. Thus, short introductory videos at the beginning of each session will help set the tone and context for Dr. Anna Pittman’s clients, helping them orient themselves to the material being presented. Additionally, the introductory videos will streamline Dr. Anna Pittman’s course by allowing her to send her clients the videos beforehand, saving her time during her live session.

3.0 User Roles and Responsibilities

3.1 Distributor

As the founder and current sole distributor of the Human Potential Program for Professionals, Dr. Anna Pittman will be responsible for releasing the delivered introduction videos as she sees fit to support and/or promote her program. Her current plan for the videos is to post them on her website.

3.2 Instructor

As the sole instructor, Dr. Anna Pittman, will incorporate the introductory videos into her Transparency curriculum and will be responsible for using the videos as she chooses.

3.3 Consumers

Individuals or organizations who have purchased the Human Potential Program for Professionals will be able to view the delivered introduction videos as Dr. Anna Pittman chooses to release them. These consumers are categorized as any party with the desire and drive to increase their productivity and overall job satisfaction.
4.0 Terminology

**Table 1.** Defines the terminology and/or acronyms used throughout this report.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client(s)</td>
<td>Participants in Dr. Anna Pittman’s “Human Potential Program for Professionals” course</td>
</tr>
<tr>
<td>HPPP</td>
<td>“Human Potential Program for Professionals”</td>
</tr>
<tr>
<td>1080p</td>
<td>A set of HDTV high-definition video modes characterized by 1080 horizontal lines of vertical resolution and progressive scan</td>
</tr>
</tbody>
</table>

5.0 Functional Requirements

- Eight separate videos shall be produced.
- Each video shall be 5 to 10 minutes in length.
- Each video shall provide an introduction to a distinct one of the eight topics listed in Table 1.
- Each video shall be produced on high quality video equipment.
- Each video shall be distributed as an individual file.
- The raw content of each video shall be archived, and then converted to MP4 format.
- Each video shall be rendered in 1080p.
- Each video shall have equalized sound quality.
- Each video shall have an introduction and conclusion.
- The introduction and conclusion shall include:
  a. Dr. Anna Pittman’s name
  b. The name of the program (HPPP)
  c. The video’s name (introduction or module number)
- Each video shall be accompanied by music.
- Each video shall contain the HPPP logo.

5.1 Functional Goal

The eight videos being produced aim to be of sufficient and professional quality for Dr. Anna Pittman to use to supply her clients with. However, strictly providing her clients with the HPPP concepts is not enough. We believe the delivery of these concepts and how they are presented to her clients is very critical to the success of the program. By presenting the concepts in a creative and meaningful manner, Dr. Anna Pittman’s clients will instinctively be receptive to learning the information and incorporating the concepts into everyday life.
5.1.1 Distribution
The videos are intended for Dr. Anna Pittman’s HPPP website. These will provide a means for potential clients to view a brief introduction of each module of HPPP so they may determine if this program is right for their needs.

5.1.2 Revisioning and Restructuring
A sample video is to be created initially in order to make sure the presented information and technology being used are up to par with Dr. Anna Pittman’s end goal of the program. After the production of the videos, no drastic restructuring should be necessary due to the fact that once the videos are produced, they will remain unchanged throughout the course. However, iterations of revisioning periods will take place to ensure that each video production meets both the program and project requirements.

5.2 Scope
The videos will be filmed, edited, and revised, all within the 9 week remaining period of the course. As described in the problem statement, the videos serve as an introduction to each HPPP module. Therefore, the scope of the information contained in each video will be broad, but will not take away from the details presented in the actual HPPP modules.

5.3 Performance
The videos should be high quality (rendered in 1080p) and will be released in an appropriate video format, to be decided upon after testing several formats. The video files should be packed into an easy to navigate .zip file, ready to be viewed in the correct order. The audio should be properly equalized across video files, with crisp and clear quality.
Appendix B – Design Document

Table of Contents

1.0 Location.............................................................................................................................................. 25
2.0 Equipment ............................................................................................................................................ 25
3.0 Video Editing ....................................................................................................................................... 25
4.0 Video Structure ................................................................................................................................... 25
5.0 References .......................................................................................................................................... 26
1.0 Location

We will film the videos in the main room of The Breathing Space, where Dr. Anna Pittman teaches and promotes her programs. This location is sufficient because Dr. Anna Pittman wants a comfortable, yet professional environment. The bright and decorative interior of The Breathing Space provides an inviting and artistic environment, without any distracting sounds from outside the space or from other people. We will find an appropriate time of day to film the videos, as too much light could hinder the quality of video, and not enough light could create a darker ambiance than what Dr. Anna Pittman is looking for.

2.0 Equipment

To film we will be using two Nikon D7100 cameras with external microphones. We do not plan on needing any additional lighting because of the natural, bright light of our filming location. We will also use a tripod to stabilize the camera.

3.0 Video Editing

We will use iMovie video editing software--provided by Innovation Space--to edit our videos. It is important that our videos look professional for Dr. Anna Pittman. We will make use of Lynda tutorials to help familiarize ourselves with iMovie editing software and we will seek outside advice from the College of Performing Arts if need be.

4.0 Video Structure

The outline below demonstrates the general flow of each of the videos. The eight videos will maintain similar structure to facilitate familiarity and a sense of ease while the client is introduced to a new module. Each video will be designed in a simple, yet effective manner so that the viewer can clearly take in the information without any unnecessary distractions (diverting animations, overwhelming music).

1. Introduction
   1.1. Title Slide
      1.1.1. Music - Subtle, yet melodic music plays to fit the tone of the video
   1.2. Fade in/out transition

2. Middle
   2.1. Various slides with key points/concepts, with voiceover when necessary
   2.2. Transition to Dr. Anna Pittman talking about key point/concept
   2.3. Repeat 2.1 and 2.2 for all of Dr. Anna Pittman’s talking points
3. End
   3.1. Overview slide
   3.2. Credits
       3.2.1. Music stops

5.0 References
Appendix C – Implementation Report

Table of Contents

Table of Figures .................................................................................................................27
Table of Tables .....................................................................................................................27
1.0 Description of Implementation ......................................................................................28
2.0 Major Tasks ....................................................................................................................28
3.0 Implementation Schedule ..............................................................................................29
4.0 Implementation Support ................................................................................................31
  4.1 Hardware ....................................................................................................................31
  4.2 Software .....................................................................................................................31
  4.3 Facilities ....................................................................................................................33
5.0 Setup .............................................................................................................................33
6.0 Outstanding Issues ..........................................................................................................34
7.0 References ......................................................................................................................34

Table of Figures

1. Detailed implementation schedule, a screenshot from Microsoft Project .........................30
2. Gantt chart of our project visually depicting schedule ......................................................30
3. Editing session of the Sample Video the team used to gain Dr. Anna Pittman’s feedback about Moss Arts Center location and overall video structure ...........................................31
4. Master patch in Max which coordinates with an FCB1010 pedalboard ..........................32
5.Looper subpatch used to layer audio tracks on top of each other ....................................33

Table of Tables

1. Outlines the Major Tasks of our implementation ............................................................28
1.0 Description of Implementation

Dr. Anna Pittman is available for filming on Mondays and Fridays, and we have concluded that the most appropriate time for our sessions are 11 a.m. Since Dr. Anna Pittman will be out of town post April 3rd, our plan has now shifted from a gradual approach of filming to capturing all the footage between the next two visits with her. This will allow for us to have everything we need footage wise within the next week, while giving us adequate time to edit and receive any sort of feedback from Dr. Anna Pittman’s perspective. Additionally, the new schedule allows time for any reshoots if necessary. We fully expect there to be reshoots to ensure Dr. Anna Pittman is happy with all of the raw footage. The set schedule of Monday/Friday also gives us the ability to plan when to rent out the necessary equipment from Innovation Space.

2.0 Major Tasks

The major tasks for implementation of the HPPP videos are displayed in Table 3.

Table 1. Outlines the Major Tasks of our implementation.

<table>
<thead>
<tr>
<th>Task #</th>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task 1</td>
<td>Technician Training</td>
<td>In order to successfully capture Dr. Anna Pittman’s vision, choose technicians to train through Innovation Space. These technicians, Cal and Emad, will train in video, audio, and lighting to familiarize themselves with the equipment and have the ability to rent this equipment from Innovation Space.</td>
</tr>
<tr>
<td>Task 2</td>
<td>Sample Footage</td>
<td>The team will shoot and edit footage of Dr. Anna Pittman in our prospective location. This footage will be accompanied with a temporary introduction or conclusion, incorporation of various camera angles, music, and transitions. This sample footage will allow Dr. Anna Pittman to give feedback about the location and structure of the overall video for future reference.</td>
</tr>
<tr>
<td>Task 3</td>
<td>Accompanying Music</td>
<td>To accompany Dr. Anna Pittman’s vision, the team will create background music to be approved by Dr. Anna Pittman. Philip, our musician, will create all the music himself.</td>
</tr>
<tr>
<td>Task 4</td>
<td>Location Selection</td>
<td>Based on the results from our Task 2, the Sample Footage, and Dr. Anna Pittman’s feedback, the team will finalize a location to film all videos.</td>
</tr>
<tr>
<td>Task 5</td>
<td>Shoot First Iteration of Footage</td>
<td>The team will shoot raw footage of Dr. Anna Pittman speaking for each of the nine videos.</td>
</tr>
<tr>
<td>Task 6</td>
<td>Preliminarily Edit First Iteration of Footage</td>
<td>Each of the nine videos will be preliminarily edited for feedback in preparation for the likely second iteration of shooting. These edits are a vital step to the final product and will determine if more raw footage needs to be captured of Dr. Anna Pittman for each video.</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Task 7</td>
<td>Shoot Second Iteration of Footage</td>
<td>The team will shoot raw footage of Dr. Anna Pittman speaking for the videos as needed based upon the previous iteration.</td>
</tr>
<tr>
<td>Task 8</td>
<td>Preliminarily Edit Second Iteration of Footage</td>
<td>The new footage will be preliminarily edited for feedback in preparation for the potential final iteration of shooting. These edits are a vital step to the final product and will determine if more raw footage needs to be captured of Dr. Anna Pittman during our final shoot.</td>
</tr>
<tr>
<td>Task 9</td>
<td>Shoot Final Iteration of Footage</td>
<td>The team will shoot raw footage of Dr. Anna Pittman speaking for the videos as needed based upon previous iterations.</td>
</tr>
<tr>
<td>Task 10</td>
<td>Logo Finalization</td>
<td>Our team is to create and finalize a logo for the HPPP to incorporate into all nine videos.</td>
</tr>
<tr>
<td>Task 11</td>
<td>Final Editing</td>
<td>All nine videos will be finalized to include music from Task 3, an introduction, a conclusion, accompanying material when appropriate, the logo from Task 10, etc.</td>
</tr>
</tbody>
</table>

### 3.0 Implementation Schedule

Figure 1 and 2 below detail the implementation schedule. Our team used Microsoft Project to develop our Gantt Chart.
<table>
<thead>
<tr>
<th>Task Name</th>
<th>Duration</th>
<th>Start</th>
<th>Finish</th>
<th>Predecessors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Meeting with Anna</td>
<td>1 day</td>
<td>Mon 2/6/17</td>
<td>Mon 2/6/17</td>
<td></td>
</tr>
<tr>
<td>Technician Training</td>
<td>7 days</td>
<td>Tue 2/7/17</td>
<td>Wed 2/15/17</td>
<td>1</td>
</tr>
<tr>
<td>Sample Footage</td>
<td>12 days</td>
<td>Thu 2/16/17</td>
<td>Fri 3/3/17</td>
<td>1,2</td>
</tr>
<tr>
<td>Accompanying Music</td>
<td>53 days</td>
<td>Tue 2/7/17</td>
<td>Thu 4/20/17</td>
<td>1</td>
</tr>
<tr>
<td>Location Selection</td>
<td>9 days</td>
<td>Mon 3/6/17</td>
<td>Thu 3/16/17</td>
<td>1,3</td>
</tr>
<tr>
<td>Shoot First Iteration Footage</td>
<td>2 days</td>
<td>Fri 3/17/17</td>
<td>Mon 3/20/17</td>
<td>5</td>
</tr>
<tr>
<td>Preliminary Edit First Iteration of Footage</td>
<td>3 days</td>
<td>Tue 3/21/17</td>
<td>Thu 3/23/17</td>
<td>6</td>
</tr>
<tr>
<td>Shoot Second Iteration Footage</td>
<td>2 days</td>
<td>Fri 3/24/17</td>
<td>Mon 3/27/17</td>
<td>7</td>
</tr>
<tr>
<td>Preliminary Edit Second Iteration Footage</td>
<td>3 days</td>
<td>Tue 3/28/17</td>
<td>Thu 3/30/17</td>
<td>8</td>
</tr>
<tr>
<td>Shoot Final Iteration Footage</td>
<td>2 days</td>
<td>Fri 3/31/17</td>
<td>Mon 4/3/17</td>
<td>9</td>
</tr>
<tr>
<td>Logo Finalization</td>
<td>53 days</td>
<td>Tue 2/7/17</td>
<td>Thu 4/20/17</td>
<td>1</td>
</tr>
<tr>
<td>Final Edit</td>
<td>13 days</td>
<td>Tue 4/4/17</td>
<td>Thu 4/20/17</td>
<td>10,7,9</td>
</tr>
</tbody>
</table>

**Figure 1.** Detailed implementation schedule, a screenshot from Microsoft Project.

**Figure 2.** Gantt chart of our project visually depicting schedule.
4.0 Implementation Support

4.1 Hardware
In terms of hardware, our team is using 2 cameras placed at different angles while filming. One is rented from Innovation Space while the other was already owned by a team member. To accompany the two cameras, the team also rented two tripods and a microphone through Innovation Space.

4.2 Software
After initially filming in the Moss Arts Center, we took the raw footage and decided to use iMovie for our editing software. In order to be proficient in editing, we researched iMovie tutorials\(^1,2\) and taught ourselves the basic and advanced ways of editing. Since we are using two cameras, we were able to use two different angles of Dr. Anna Pittman in order have some diversity. Audio was take from one of the two cameras (the closer camera to Dr. Anna Pittman). In addition to the video footage and its accompanying audio, we added background music to compliment the video. Figure 3 gives a screenshot of an editing session.

![Figure 3](image.png)

**Figure 3.** Editing session of the Sample Video the team used to gain Dr. Anna Pittman’s feedback about Moss Arts Center location and overall video structure.

In our initial meeting with Dr. Anna Pittman, she mentioned that music could be a nice addition to the videos, as long as it blended well with the mood and setting and was not too distracting. With the goal of providing music that adds to the ambience of the video sessions, it is important to brainstorm musical ideas that flow with the information Dr. Anna Pittman is presenting and not against it. An interesting technology that allows for considerable musical creativity is
Cycling 74’s Max/MSP software, with which two of the team members have experience creating music. Using various pieces of hardware and an electric guitar along with Max/MSP, an audio clip was created to add to the Sample Video to test the flow of both video and audio combined. The audio clip used is approximately 30 seconds in length and is looped throughout the video to provide subtle, yet melodic support for Dr. Anna Pittman’s program. With approval from Dr. Anna Pittman on the samples of music to be implemented into the video program, a new audio clip is to be created for each video to provide diversity to the various topics covered in the lessons.

Here is a list of the equipment used to create music in coordination with Max/MSP:

- Focusrite Scarlett 2i4 USB Audio Interface
- Behringer FCB1010 MIDI Foot Controller
- Multiple ¼ inch instrument cables
- PRS SE electric guitar

First, a drum sample is looped in Max to provide a beat and tempo for subsequent additions to the track. A customizable synthesizer voicing from the Crystal VST plugin is then automatically played upon each iteration through the drum track. By implementing a 3-track looper and several guitar effects into the FCB1010 foot controller, multiple guitar tracks are then layered on top of the drum/synthesizer rhythm. The guitar signal is manipulated by Native Instruments’ Guitar Rig VST plugin to create the different guitar tones. Once the respective tracks are correctly looped, the “sfrecord~” object in Max writes the audio sample to a file. Figures 4 and 5 give screenshots of the music environment created in Max.

![Figure 4. Master patch in Max which coordinates with an FCB1010 pedalboard](image-url)
4.3 Facilities

For our implementation, the facility that we choose plays a huge role in the success of our project. In preparation for the recording of these videos we brainstormed a number of possible facilities under the following constraints: these facilities would provide consistent lighting, would be consistently vacant so that civilians wouldn’t be getting in the shot, and would fit the professional aesthetic that Dr. Anna Pittman is looking for. After establishing the criteria that the facility would need to have, we ultimately decided on the Moss Arts Center. The area in the Moss Arts Center that we decided on was the foyer behind the stairs on the first floor.

After this session of filming at the Moss Arts Center, we then cut and edited the video to show Dr. Anna Pittman to see her thoughts on the location and whether or not she wanted to continue filming there. In turns out that Dr. Anna Pittman did not feel connected to the space after watching the version we filmed. Therefore, she suggested we would film in The Breathing Space facility where she feels more comfortable and where the criteria we suggested would be more consistent.

5.0 Setup

When our group arrives at The Breathing Space facility for a filming session we are very exact about our setup process. Having taken the Nikon D7100 introductory course at Innovation Space, we are very well-versed on preparing camera settings for video, swapping lenses if need be, and using the tripod to film certain angles. In addition, we realize that audio captured on the DSLR
camera without an external mic is risky because of unwanted noise captured in the background. Due to this realization, we have also equipped ourselves with an external mic that we attach to the top of the closest camera in relation to Dr. Anna Pittman. Along with this attachment, we add a wind muff microphone cover over the external mic to combat extra noise so that there is no doubt that the audio will be clear enough for the viewer. For consistency purposes, once the cameras are attached to the tripods and we have found an angle that Dr. Anna Pittman likes for the shot, we make sure that we put a place marker on the floor where the legs of the tripods are located so that there are no variations in our shot within a certain angle.

6.0 Outstanding Issues

- Abrupt Transitions: as noted by Dr. Anna Pittman, the sample video lacks smooth transitions between camera angles. A solution may be to transition only when there is a pause in Dr. Anna Pittman’s dialogue.
- Close-up, side shot camera angle: due to Dr. Anna Pittman’s request of eliminating the railings in the background of our Moss Arts Center shot, the camera angle of the close-up shot was greatly reduced. As a result, there is not enough disparity between the front and side shots. Since we are changing filming locations to the Breathing Space, we will also adjust the angle of the side-shot to be more representative of the angle in our initial tests. This angle pairing will also help with the overall smoothness in camera transitions.
- Video Introductions: Dr. Anna Pittman would like us to include her name, as well as her credentials, at the beginning of each video to give the viewer necessary background information about her.
- Overlayed Text: Dr. Anna Pittman requested that we have text come up on the screen when necessary. An example of this would be when she is listing the titles of her 8 video lecture topics in her introduction video; the corresponding name would appear on screen in sync with her listing them out.
- Logo: Dr. Anna Pittman also asked us if it were possible to come up with a logo that she could show at the end of each video. We have a few possible solutions to this since nobody in particular has experience with graphical design. The first is that a relative of Jimmy does graphical design work. Alternatively, we would take the task on ourselves and come up with something on our own.

7.0 References


3. Cycling 74’ MAX. https://cycling74.com/products/max/
Appendix D – Prototyping

Table of Contents

Table of Figures ........................................................................................................................................36

Table of Figures

1. First logo prototype.................................................................................................................................37
2. Third logo prototype.................................................................................................................................38
3. On-screen content integration................................................................................................................39
4. Filming setup at The Breathing Space....................................................................................................40
Having filmed most of the footage for our client’s videos, we have been able to fully edit two of the videos--providing our client with a prototype for the rest of the project. The prototype video has helped serve as a baseline for the other videos that we will be creating for our client. Our prototype video sought to cover three main goals:

- Introduction with a logo
- On-screen content integration
- Introductory, background, and conclusion music

The introduction to each video will follow a similar format to that of the prototype video. The topic/title of the video appears with Dr. Anna Pittman’s name and credentials below it, followed by the HPPP logo. After the introduction slide, Dr. Anna Pittman introduces herself, the program, and the topic of the video.

Our team came up with three different prototype logos for HPPP. The first was a generic sketch-up of a leaf and some meaningful words representing HPPP below it (see Figure 1). The second logo incorporated animation with a tree and the name of the program. The last logo prototyped was similar to the second one, but with no animation. For the prototype video our team used the third prototyped logo (see Figure 2).

![Figure 1. First logo prototype](image)
As part of the requirements established in the design phase of this project, our team and client wanted to be able to integrate on-screen content in the videos. The prototype video includes such content (see Figure 3). The lettering is white in order to contrast the darker background and make it easy for the viewer to read.

Figure 2. Third logo prototype
The music heard throughout the prototype video was created by our team with the goal of providing a relaxing and ambient setting. Three different music samples were prototyped which can be distinguished in the prototype video. Each sample was uniquely created to fit the introduction, background, and conclusion of the video. The volume of the background music was adjusted carefully so that Dr. Anna Pittman’s voice and the music did not conflict with each other.

The camera angles, distances, and setup at the filming location (The Breathing Space) were important in establishing the prototype video. Some considerations taken into account were the background aesthetic and the use of an elementary teleprompter. Ultimately, the background we saw fit to film against had beautiful contrast with simple colors and a natural look--providing a very warm feel. In the side-angle camera view, a wooden door can be seen in the background along with a conveniently placed plant--covering up the door knob (see Figure 4). While filming, a large whiteboard with Dr. Anna Pittman’s printed out notes was used to help guide guide the videos. The board was placed directly behind that camera--reducing Dr. Anna Pittman’s eye movement from the camera. Another important aspect of filming was making sure the cameras were placed in the same locations across different filming days. To ensure this was the case, tape was placed on the ground, marking the legs of each camera tripod (see filming setup Figure 4).
Figure 4. Filming setup at The Breathing Space
Appendix E – Refinement

Table of Contents

Table of Figures .........................................................................................................................41

Table of Figures

1. Camera angle #1....................................................................................................................42
2. Camera angle #2....................................................................................................................43
3. Introduction to Dr. Anna Pittman’s Empathy video..............................................................44
4. Subject of the video as well as the name of Dr. Anna Pittman’s program will show briefly when she begins each separate video.................................................................44
5. Screenshot of closing segment of Dr. Anna Pittman’s Empathy video..............................45
Having discussed our prototyping process and having the process be completely transparent with Dr. Anna Pittman, we have been able to receive feedback and establish what we need to refine in order for us to completely fulfill our client’s goals. The refinements to be made mostly come in the form of certain edits that Dr. Anna Pittman would like us to alter in the footage that we have captured, along with add-ons that we will implement in the videos. To begin, let us first discuss the abrupt transition issue that we, along with our client, have noticed within our videos. As we have established in our project, we have two cameras shooting footage for each video to provide a variety of angles. However, an issue that we must resolve is making sure that we are transitioning from angles smoothly, or at a point in time where Dr. Anna Pittman is not mid-sentence. Smooth transitions are necessary in order to aid the viewer in understanding the current concept at hand, as well as providing a professional flow to Dr. Anna Pittman’s message. We plan on fixing this issue by only making transitions in-between concepts or between breaths that Dr. Anna Pittman makes during her explanations. By doing this, the viewer can still be provided with a variety in camera angles while not being distracted from listening to Dr. Anna Pittman’s content. Figures 1 and 2 show the different camera angles we will be transitioning back-and-forth from.

**Figure 1.** Camera angle #1
The second refinement that must be made for our project to be considered complete is the addition of distinct introduction slides that correspond to each video. As we have mentioned earlier in our report, our client wants to provide her viewers with eight different concepts and topics as part of the Human Potential Program for Professionals. With that being said, we must create an introductory segment for each video providing the viewer with a visual “heads-up” of what topic is about to be discussed beforehand. For example, the “Empathy” slide we have created is to be placed at the very beginning of the video, allowing for the viewer to be informed on which topic is about to be discussed. The topic of the video will also be accompanied by her logo, as well as Dr. Anna Pittman’s full name and title. Figures 3 and 4 depicted below provide more in depth analysis of what has been created.
As you can see, we must continue to create these introductory segments and headers to be placed at the beginning of each video so that the viewer is reminded of what subject Dr. Anna Pittman is about to discuss in each video. For example, another video will have “Communication” instead of “Empathy” in the introductory segment and header in the beginning of that video, while still being accompanied by the name of Dr. Anna Pittman’s program.
Furthermore, the next refinement to implement before the completion of our project involves the audio/sound incorporated in the videos. First, once the transitions, slides, and headers are finalized on each video to meet Dr. Anna Pittman’s requirements, we will begin refining the audio as well. This will include listening through each video and making sure that all ambient noise in the background is eliminated so that the viewer is not distracted by any outstanding sounds and is only exposed to Dr. Anna Pittman’s voice. This should not be much of an issue as we sound checked the recording location prior to recording our final takes, but the precaution should still be taken. In addition to our sound check, a large part of unwanted background audio was eliminated due to the dead cat attachment to the external microphone that was provided with our cameras from Innovation Space. With that being said, we were informed by Innovation Space that the dead cat attachment only eliminates wind interference, so there is still testing to be done. Additionally, more music is in production to supplement the videos as a backdrop while Dr. Anna Pittman talks. Dr. Anna Pittman has made it clear to us that she likes the idea of having a different background music in each video to give them their own unique feel. These audio samples are being created with a guitar melody accompanied with the audio production software, MAX, to fulfill this request. Upon creating each audio sample, we have been forwarding them individually to Dr. Anna Pittman to ensure she approves each sound for her video, which is also the case for future videos that are still in production.

Lastly, our client has informed us that she wants a still image to serve as the background in the closing segment of each video. This will be accompanied by her contact information, as well as her credentials and an ad to a free consultation session she provides. Figure 5 shows an example of such a closing that is used in the Empathy video.

![Figure 5. Screenshot of closing segment of Dr. Anna Pittman’s Empathy video.](attachment:image.png)
In conclusion, we must continue to find images for the conclusion segment of each video that corresponds well with the theme of our clients program. This process is necessary because we have previously been instructed by Dr. Anna Pittman to use an alternate image to one that was put in a prototype video we sent her. Dr. Anna Pittman felt that the original image was not congruent with the overall theme of the video, and provided her insight on what she found most appropriate. One challenge in this is finding more images that have no copyright restriction, so that we may use them in Dr. Anna Pittman’s videos. We, along with our client, are aware that we cannot simply take any image that we find from the Web and use it in our videos. This is an obstacle we will have to overcome while finding the remainder of the images that will be used in the closing segment.
Appendix F – Testing and Refinement

Table of Contents

Table of Tables .................................................................................................................. 47
1.0 Viewer Feedback ............................................................................................................. 48
  2.0 Evaluation of Feedback ............................................................................................... 49

Table of Tables

1. Viewer Feedback ............................................................................................................. 48
Due to our level of involvement with this project, each respective group member has been working closely with the continuous refinement/testing process throughout the duration of the project, giving feedback to help mold the videos into exactly what our client wants. However, at this point in the development of the videos, we have become accustomed to the presented material as well as the general flow of information. Therefore, it is necessary to seek feedback from outside of the project group to gauge other individuals’ interests in the program with respect to the videos we have created. Seeing that our goal has been to create high-quality introductory videos for HPPP that will intrigue viewers and get them interested in the program, we decided that the best strategy for testing would be to have other individuals view an introductory video and then give us feedback on several determining factors of the quality of the video.

Each viewer was sent a general description of the project and background information on Dr. Anna Pittman and the Human Potential Program for Professionals, along with a link to the most up-to-date version of our video for the “Empathy” domain. After watching and analyzing the video, the viewer was to fill in a table with several areas to address: quality of both video and audio, quality of content and information presented throughout the video, and any further comments and observations. These general, yet important areas of feedback are to maximize the benefits of getting unbiased evaluations of our video structure and flow of information. By incorporating both qualitative and quantitative sections for feedback, we can better determine each viewer’s full perspective and interest in the videos, as well as what our focus should be for future testing and refinement.

1.0 Viewer Feedback

Table 1. Viewer Feedback

<table>
<thead>
<tr>
<th>Quality of video/audio</th>
<th>Quality of content</th>
<th>Comments and suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Very nice intro/ending text</td>
<td>-Client does a great job of explaining psych terms with details</td>
<td>Maybe add a few more bits of text to support her while she is talking.</td>
</tr>
<tr>
<td>-Clear visual of clients face and audio of her voice</td>
<td>-Client keeps calm and welcoming facial expression throughout the video</td>
<td>Other than a possible improvement in video quality, there wouldn’t be much to change.</td>
</tr>
<tr>
<td>-Peaceful background music to support</td>
<td>-An example of how she’s “connecting” to others would have conveyed her main points better.</td>
<td>I would improve the lighting and change the content a bit so people can better relate, rather than having more “meta” explanations.</td>
</tr>
<tr>
<td>-I thought the streaming quality was good but could be upgraded to 60 fps for best possible</td>
<td>-Conveys the fact that she has</td>
<td></td>
</tr>
</tbody>
</table>

48
2.0 Evaluation of Feedback

The initial evaluations were on the positive side. There were only positive comments about the music aspect of the video, leaving our team feeling confident with our music integration. We determined we do not need additional refinement in the musical aspect. There were a couple of comments having to do with content, such as suggestions to include more examples. Given time constraints and the fact Dr. Anna Pittman is no longer available to film, we are going to have to work with the raw footage we already have. To address this, we can shift through the other takes of the empathy module to see if we may incorporate an additional example seamlessly. Overall, each viewer is interested in the program but might suggest making refinements to improve the introductory video.